DSIM User’s Manual

Version 2020a
Release 1

January 2020

Copyright © 2020 DSIM Technology Co.
All rights reserved. No part of this manual may be photocopied or reproduced in any form or by any means without the written permission of DSIM Technology Co.

Disclaimer

DSIM Technology Co. (“DSIM Tech”) makes no representation or warranty with respect to the adequacy or accuracy of this documentation or the software which it describes. In no event will DSIM Tech or its direct or indirect suppliers be liable for any damages whatsoever including, but not limited to, direct, indirect, incidental, or consequential damages of any character including, without limitation, loss of business profits, data, business information, or any and all other commercial damages or losses, or for any damages in excess of the list price for the licence to the software and documentation.

DSIM Technology Co.

Email: support@dsimtechnology.com.cn
Web: dsimtechnology.com.cn
## Contents

1 **General Information**  
1.1 Introduction 1  
1.2 Modeling Power Electronic Systems in DSIM 1  
1.3 Simulating Power Electronic Systems in DSIM 4  
1.4 Software/Hardware Requirement 4  
1.5 Installing the Program 4  
1.6 Simulating a Circuit 5  
1.7 Simulation Control 5  
1.8 Component Parameter Specification and Format 6  

2 **Circuit Schematic Design**  
2.1 DSIM Environment 8  
2.2 Creating a Circuit 11  
2.3 File Menu 12  
2.4 Edit Menu 13  
2.5 View Menu 14  
2.6 Subcircuit Menu 14  
2.6.1 Creating Subcircuit - In the Main Circuit 16  
2.6.2 Creating Subcircuit - Inside the Subcircuit 16  
2.6.3 Connecting Subcircuit - In the Main Circuit 17  
2.6.4 Other Features of the Subcircuit 18  
2.7 Elements Menu 19  
2.8 Simulate Menu 20  
2.9 Options Menu 20  
2.9.1 Setting Option 21  
2.10 Utilities Menu 23  
2.11 Window Menu 23  
2.12 Help Menu 24  
2.13 Managing the Element Library 24  
2.13.1 Creating a Secondary Image 24  
2.13.2 Adding a New Subcircuit Element into the Library 25  

3 **Waveform Display in SIMVIEW**  
3.1 File Menu 28  
3.2 Edit Menu 28  
3.3 View Menu 28  
3.4 Axis Menu 29  
3.5 Screen Menu 32  
3.6 Measure Menu 36  
3.7 Analysis Menu 37  
3.8 Label Menu 37  
3.9 Option Menu 38  
3.10 Exporting Data 39
4 Examples

4.1 Example 1: 200kHz LLC Circuit 40
4.2 Example 2: 50kVA Solid-State Transformer 41
4.3 Example 3: 10kV four-port Solid-State Transformer 43
4.4 Example 4: Experimental Verifications of the Transient Model 44
1.1 Introduction

DSIM is a simulation software specifically designed for power electronics. With a groundbreaking simulation engine and innovative modeling approach which fully exploits the characteristics of power electronic systems, it achieves an unprecedented and unparalleled performance. It increases the simulation speed by several orders of magnitude compared with any existing simulation software. Moreover, its ability to simulate large converter systems and at the same time switch transients is unique, and it makes it ideally suited for large scale power converter systems, high power converter systems, microgrid, and any systems that are computation intensive.

The DSIM simulation environment consists of the schematic program DSIM, a DSIM simulator engine, and the waveform processing program SIMVIEW. The simulation process is illustrated as follows.

This manual covers all necessary details about DSIM. The organization of this manual is as follows:

- **Chapter 1**: DSIM circuit structure, software/hardware requirement, and parameter format.
- **Chapter 2**: DSIM environment and how to build a DSIM schematic.
- **Chapter 3**: Simulation result display and analysis with Simview.
- **Chapter 4**: Examples showing the performance of DSIM.

First of all, in Chapter 1, the working principles of DSIM will be briefly introduced, in terms of **modeling** and **simulating**, so that users can have a basic understanding of the DSIM software.

1.2 Modeling Power Electronic Systems in DSIM

Power electronic systems are intrinsically hybrid dynamic systems composed of continuous states and discrete events. Usually, continuous states include physical variables such as capacitor voltage and inductor current, while discrete events, such as switching events of semiconductor switches, lead to the transition of the system from one operating mode to another. In power electronic systems, these continuous states and discrete events not only coexist, but also deeply interact with each other and co-determine the operating mode of the system, as shown below.
Power electronic system is represented in DSIM in four blocks: power circuit, control circuit, sensors, and switch controllers. The figure below shows the relationship between these blocks.

The power circuit usually consists of switching devices, RLC branches and transformers. For the switching devices, DSIM do not offer discrete switch elements such as a single diode, IGBT, or MOSFET, to build the converter. Instead, switch modules such as two-level bridge leg, three-level T-type bridge leg and three-level NPC bridge leg should be used to construct the circuit. See Elements >> Power >> Switches >> Switch Modules for all the switch modules supported in DSIM. DSIM does support bi-directional switches, but the bi-directional switch should be used for one-time event only (such as load change, open-circuit, or short-circuit). It should not be used for PWM operation as the DSIM engine is not optimized to handle it.

For the switching modules, two types of model are supported in DSIM, namely ideal model and transient model.

**Ideal Model**

If ideal model is selected, DSIM will model the switch as a small resistance in on-state and as open circuit in off-state. The on-state resistance is defined as a parameter called Switch Resistance. It is considered the same for all the active switches and the diodes in the module. The off-state resistance is ignored. The transitions between on-state and off-state are also ignored, so the system can be viewed as a piecewise-linear time-invariant (PLTI) system, which can be characterized by a set of $n$ first-order ordinary differential equations.
Taking two-level bridge leg as an example, the figure below shows how DSIM model the switch module. Because DSIM does not support pure-diode bridge (and therefore dead-time) temporarily, "00" is also an illegal control input. Please refer to online help of each module to see its legal control input.

**Transient Model**

Switching transients between the two steady states are sometimes significant in terms of device protection, switching loss, voltage/current balancing and EMI analysis. However, simulating switching transients in a large system is often challenging due to high stiffness of the circuit. DSIM adopts an innovative modeling approach called **Piecewise Analytical Transient (PAT)** model, which is capable of simulating the switching transients in a very fast and stable way. All the model parameters are available from device datasheet.

Taking a two-level bridge leg as an example, the equivalent circuit for IGBT/diode bridge and for SiC MOSFET/diode bridge is shown as below. Note that the stray inductors are already incorporated in the model whose values should be entered as parameters. One should not put extra stray components in the main circuit which will cause highly stiff equations and therefore low simulation speed.

DSIM now offers transient model for all the switching modules except three-level NPC bridges. One can choose between IGBT/diode model and SiC MOSFET/diode model. Please turn to online help for more information about the definitions of the model parameters. In Chapter 4, comparisons of the model results and experimental results will be presented.
The control circuit is represented in block diagram. DSIM supports only digital control temporarily. Components in z-domain, logic gates and computational blocks can be used in the control circuit. Sensors are used to measure power circuit quantities and pass them to the control circuit. Gating signals are then generated from the control circuit and sent back to the power circuit through switch controllers to control switches.

The whole DSIM engine works in an event-driven manner, and one should use the switch controllers under **Elements >> Other >> Switch Controllers** to generate switching signals. The offered components cover most of the PWM generators including carrier-based PWM, SVPWM, square wave controller, etc. Otherwise, one should be careful in current DSIM version since switching events may not be located accurately.

### 1.3 Simulating Power Electronic Systems in DSIM

DSIM engine uses a discrete state (DS) algorithm under an event-driven (ED) manner. It fully exploits the characteristics of power electronic systems and exhibits ultra-fast performance especially in large-scale or high-frequency systems, where typically hundred-fold acceleration can be achieved under the same accuracy, compared with existing simulation tools. Chapter 4 shows some examples where such comparisons are presented.

The DS algorithm is intrinsically a variable step-size algorithm which achieves adaptive numerical integration of system states with less computational costs, and the ED manner avoids unnecessary iterative calculations for the frequently-occurred switching events in power electronics. Since a variable step-size algorithm is employed, it’s not necessary for users to select a proper step-size. Instead, DSIM engine will choose the step-size adaptively in each calculation step. The following figure illustrates the DSIM simulation framework compared with the conventional one.

![Simulation framework comparison](image)

**Conventional simulation framework vs. DSIM simulation framework**

#### 1.4 Software/Hardware Requirement

DSIM runs in Microsoft Windows 10 or higher on personal computers. A minimum of 1GB RAM memory is needed.

#### 1.5 Installing the Program

Some of the files in the DSIM directory are:

- **DSIM.exe**  
  DSIM circuit schematic editor

- **SIMVIEW.exe**  
  Waveform processing program

File extensions used in DSIM are:

- *.dsimsch  
  Schematic file

- *.dsimpjt  
  Project file

- *.schpack  
  Package file
1.6 Simulating a Circuit

To simulate the buck converter circuit “buck.dsimsch” in "examples\dc-dc":
- Start DSIM. From the File menu, choose Open Examples..., then, go to "dc-dc" folder to load the file “buck.dsimsch”.
- From the Simulate menu, choose Run DSIM to start the simulation. Simulation results will be saved to File “buck.smv”.
- By default, Auto-run SIMVIEW is selected in the Options menu. SIMVIEW will be launched automatically. In SIMVIEW, select curves for display. If this option is not selected, from the Simulate menu, choose Run SIMVIEW to start SIMVIEW.

1.7 Simulation Control

DSIM adopts a variable-step algorithm, and users do not have to specify the simulation step. The Simulation Control element defines parameters and settings related to simulation.

To place the Simulation Control in the schematic, go to the Simulate menu, and select Simulation Control.

<table>
<thead>
<tr>
<th><strong>Image:</strong></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Time</td>
<td>The total simulation time, in sec.</td>
</tr>
<tr>
<td>Maximum step size</td>
<td>The maximum time step, in sec. If the adaptively chosen time step is larger than the &quot;Maximum step size&quot;, the step size is forced to be &quot;Maximum step size&quot;.</td>
</tr>
<tr>
<td>Relative error</td>
<td>&quot;Relative error&quot; is used to control the numerical error in state integration. The engine chooses the step size based on &quot;Relative error&quot;. Decreasing it leads to smaller time step, hence more accurate results but longer consuming time. In most cases, at least 1e-3 &quot;Relative error&quot; is recommended. One can also decrease it until no changes are observed in the simulated waveforms.</td>
</tr>
<tr>
<td>Maximum display step size</td>
<td>The &quot;Maximum display step size&quot; (in sec.) is used to limit the display step between two points in the output waveforms. This is typically used for high-frequency waveforms when the engine gives accurate results at each point, but with low &quot;sampling frequency&quot; due to relatively large step size, as shown below (red waveform). Decreasing &quot;Maximum display step size&quot; forces the engine to show details between two points (i.e. during each time step), as shown below (blue waveform). This will cause extra calculations but is more efficient than decreasing the &quot;Maximum step size&quot;. It is recommended to use larger &quot;Maximum display step size&quot; to save time when simulated waveforms are displayed with enough resolution.</td>
</tr>
</tbody>
</table>
Some tips on how to change simulation settings:

1) Try decrease the "Relative error" if you think the simulation is not accurate enough;
2) Try decrease the "Maximum display step size" if you think the results have low resolution;
3) Try decrease the "Maximum step size" when you find that the simulation results do not converge.

1.8 Component Parameter Specification and Format

The parameter dialog window of each component in DSIM has three tabs: Parameters, Other Info, and Color, as shown below.

The parameters in the Parameters tab are used in the simulation. The information in the Other Info tab, on the other hand, is not used in the simulation. It is for reporting purposes only and will appear in the parts list in View >> Element List in DSIM. Information such as device rating, manufacturer, and part number can be stored under the Other Info tab.

The component color can be set in the Color tab.

Parameters under the Parameters tab can be a numerical value or a mathematical expression. A resistance, for example, can be specified in one of the following ways:

- 12.5
- 12.5k
- 12.5Ohm
- 12.5kOhm
- 25./2.0hm
- R1+R2
- R1*0.5+(Vo+0.7)/Io

where R1, R2, Vo, and Io are symbols defined either in a parameter file (see Section 4.1), or in a main circuit if this resistor is in a subcircuit (see Section 6.3.4.1).

Power-of-ten suffix letters are allowed in DSIM. The following suffix letters are supported:
A mathematical expression can contain brackets and is not case sensitive. The following mathematical functions are allowed:

- ** + addition
- \(- \) subtraction
- \(*\) multiplication
- \(/\) division
- \(^\wedge\) to the power of \([i.e. \ 2^3 = 2 \times 2 \times 2]\)
- \(^**\) to the power of \([i.e. \ 2^{**3} = 2 \times 2 \times 2]\)
- \(\sin(x)\) sine
- \(\cos(x)\) cosine
- \(\tan(x)\) tangent
- \(\arcsin(x)\) arcsine
- \(\arcsin(x)\) arcsine
- \(\arccos(x)\) arccosine
- \(\arccos(x)\) arccosine
- \(\arctan(x)\) arctangent
- \(\arctan(x)\) arctangent
- \(\arctan2(y,x)\) arctangent with \(x\) and \(y\) defined
- \(\sinh(x)\) hyperbolic sine
- \(\cosh(x)\) hyperbolic cosine
- \(\tanh(x)\) hyperbolic tangent
- \(\text{pow}(x,y)\) \(x\) to the power of \(y\)
- \(\text{pwr}(x,y)\) \(\text{abs}(x)^y\)
- \(\text{sqr}(x)\) square of \(x\), \(i.e. \ x^2\)
- \(\text{sqrt}(x)\) square root
- \(\text{hypot}(x1,x2,x3...)\) square root of \(x1\) squared plus \(x2\) squared, plus \(x3\) squared, etc., \(i.e. \ \text{sqrt}(x1^2 + x2^2 + x3^2 + ...)\)
- \(\text{hypot}(x_{\text{array}})\) The input is an array, and it returns the square root of the sum of the array cells squared, \(i.e. \ \text{sqrt}(x_{\text{array}[0]^2 + x_{\text{array}[1]^2 + x_{\text{array}[2]^2 + ...}})\)
- \(\exp(x)\) base-\(e\) exponential of \(x\), \(i.e. \ e^x\)
- \(\ln(x)\) (or \(\log(x)\)) natural logarithm of \(x\) (base \(e\))
- \(\log10(x)\) common logarithm of \(x\) (base 10)
- \(\text{abs}(x)\) absolute
- \(\text{sign}(x)\) sign function that returns 1 if \(x > 0\), -1 if \(x < 0\), and 0 if \(x = 0\)
- \(\text{ceil}(x)\) function that returns the integer larger than \(x\)
- \(\text{floor}(x)\) function that returns the integer smaller than \(x\)
- \(\text{min}(x1,x2,x3...)\) Minimum value of \(x1\), \(x2\), \(x3\), etc. (no limit on the number of inputs)
- \(\text{min}(x_{\text{array}})\) The input is an array, and it returns the minimum value of the array cells
- \(\text{max}(x1,x2,x3...)\) Maximum value of \(x1\), \(x2\), \(x3\), etc. (no limit on the number of inputs)
- \(\text{max}(x_{\text{array}})\) The input is an array, and it returns the maximum value of the array cells
The schematic editor program provides interactive and user-friendly interface for circuit schematic entry and editing. The program consists of an integrated set of windows, tools, menus, toolbars, and other elements that allow you to create, simulate, and refine your circuits in one place.

2.1 DSIM Environment

The following figure shows typical screen display of the DSIM environment. In the figure, to illustrate as an example, two circuit files are open: LLC 200kHz circuit and buck converter circuit.

By default, the menu bar and the standard toolbar appear on top of the window, while the frequently used element bar appears at the bottom, and the Project View is on the left hand side.

On the right hand side is the Design window. This is a graphic editor where users can build and edit their simulation circuit schematics. User may arrange schematics in the Design window in tiles (as shown above), or in tabs (as shown below).
The Project View window provides an organized tree view of user’s projects and their related files, as well as the simulation result graphs. Each circuit is treated as a project. The following content are displayed in stacking tiers in the project view:

- **Project Name:** Usually this is the same as the top level circuit file name.
- **Documents:** Any files related to the project, for example document, datasheet, etc.
- **Study:** Name of the study
- **Schematic:** The schematic files, top level and subcircuits.
- **Graphs:** All probes in the schematic are included in the graph list.

The following shows a buck converter example in the Project View.

In this example, the project is the LLC 200kHz converter. It contains one study. The main circuit is "LLC_200kHz.dsimsc". There are several simulation waveforms.
After the simulation is done, the waveforms I(L1) can be loaded into Simview by simply double clicking on the waveform names in Project View. The waveforms can also be embedded into the schematic by dragging into the schematic. For example, the figure above shows the I(L1) waveform embedded in the schematic.

A project may contain multiple studies. For example, one may study the converter circuit with a different switching frequency. To create another study out of an existing study, right click on the existing study "LLC_200kHz" and select **Create Study copy**. A dialog window will appear as shown below to allow you to define the new study name and determine if you wish to make a copy of the subcircuit.

In this example, we will create a new study called "LLC_100kHz". After confirmation, the new study is created as shown below.

To add an existing schematic file into the project as another study, right click on the project "LLC_200kHz" and select **Add Study**. To save the project, right click on the project "LLC_200kHz" and select **Save Project**.
2.2 Creating a Circuit

The basic and most commonly used functions provided for circuit creation are:

**Get Element**

There are several ways to get an element from the element library. One is to use the pull-down menu. Go to the Elements menu, and go into the submenu and highlight the element to be selected.

The most often used elements can be selected in the Element Toolbar. It is located at the bottom of the schematic editor screen by default.

Another way is to use the Library Browser, as shown below. The Library Browser provides a convenient way of navigating through the library. To launch the Library Browser, go to View >> Library Browser.

**Place**

Once an element is selected from the menu, the image of the element will appear on the screen and move with the mouse. Click the left button of the mouse to place the element at desired location on schematic.

**Select Element(s)**

To select an existing element on a schematic, click on the element. A rectangle will appear around the element. To select a section of a circuit, keep the left button of a mouse pressed and drag the mouse until the rectangle covers the selected area.

**Rotate**

Before the element is placed, right click to rotate the element. After an element is selected, select Edit >> Rotate to rotate the element.

**Wire**

To connect a wire between two nodes, select Edit >> Wire. The image of a pen will appear on the screen. To draw a wire, keep the left button of the mouse pressed and drag the mouse. A wire always starts from and end at a grid intersection.

For easy inspection, a floating node is displayed as a circle, and a junction node is displayed as a solid dot.

**Label**

If two or more nodes are connected to the same label, they are connected. It is equivalent as though they were connected by wire. Using labels will reduce the cross-wiring and improve the schematic layout.

The text of a label can be moved. To select the text, left click on the label, then press the Tab key.

**Assign**

To assign the parameters of an element, double click on the element. A dialog box will appear. Specify the values and hit the <Return> key or click on OK.
Move To move an element or a circuit block, select the element/circuit block and drag the mouse while keeping the left button pressed.

Pan Schematic To scroll schematic, right click and drag the mouse.

2.3 File Menu

The following functions are provided in the File menu for various file operations:

New Create a new schematic with a single worksheet with no size limit.
New (worksheet) Create a new schematic with a predefined worksheet size.
Open Open an existing schematic file.
Open Examples Open sample schematic files that come with the software.
Search Examples Search for sample schematic files that relevant to user’s request.
Change Worksheet Change the worksheet size.
Size
New Project Create a new project.
Open Project Open an existing project.
Save Project Save current project.
Close Close the current schematic file.
Close All Close all schematic files.
Save Save the current schematic file.
Save As... Save the current schematic file to a different name.
Save All Save all schematic files.
Save with Password Save a schematic file so that it is protected with a password. When a file is password protected, it can still be used in the simulation, but one needs to enter the correct password in order to see the schematic. The password protection is used in situations where the person who created the file needs to share it with someone else, but does not wish to reveal the details of the schematic.
Save in Package File Save a schematic file and all associated files to one single package file (.schpack). This is especially useful if the main circuit calls multiple subcircuits, and one needs to send the files to someone else. Rather than finding and collecting all the subcircuit files, one can just create the package file and send out the single package file.
Print Print the schematic. Note that the schematic is printed as it appears on the screen. If you zoom in or out the schematic, the printout will be changed accordingly.
Print Preview Preview the printout.
Print Selected Print only a portion of the schematic selected.
Print Selected Preview Preview the printout of the portion of the schematic selected.
Print Page Setup Adjust the print page position and set the print page legend.
Printer Setup Set up the printer.
Exit Exit the schematic program.
2.4 Edit Menu

The following functions are provided in the Edit menu for circuit editing:

**Undo**
Undo the previous change.

**Redo**
Go back to the state before undoing the changes.

**Cut**
Cut the selected circuit out of the schematic. The circuit that is cut can be pasted back.

To delete an element or a portion of the circuit, select the item and hit <Delete> key.

**Copy**
Copy an element or a portion of a circuit into a buffer, which can then be pasted back.

**Paste**
Paste back the copied element or circuit.

**Select Matched Elements**
Select the elements which matches the specification.

**Select All**
Select the entire schematic. To select only a portion of the schematic, left click and drag the mouse.

**Copy to Clipboard**
Copy the schematic image to the clipboard which can then be pasted back in another software. One can choose one of the three options: Metafile Format, Color Bitmap, or Black and White bitmap. The metafile format is vector based, and gives better image quality especially when the image is resized. The Black & White option will result in a smaller image file size as compared to the color bitmap.

**Draw**
Draw images on the schematic for display purposes. The following images are provided: line, ellipse, rectangle, half-circles, bitmap images, and graph.

To draw a bitmap image: left click the mouse and drag the mouse to define the area that will contain the bitmap image. Then select the bitmap file.

To draw a graph, left click the mount and drag the mouse to define the area that will display the waveform of selected probe.

**Change All Text Font**
Change the font for all the text in the opened file.

**Change All Text Link Font**
Change the font for all the text link in the opened file.

**Place Text**
To place text on the screen, choose Text. Enter the text in the dialog box, and click the left button of the mouse to place it.

**Place Wire**
Enter the wiring mode. The cursor will change to the shape of a pen.

**Place Label**
Place a label on the schematic. When two nodes are connected to two labels of the same name, they are considered physically connected.

**Set Node Name**
Name the node. This name will be captured for SPICE simulation and netlist generation.

**Edit Attributes**
When an element is selected, choose Attributes to bring out the property dialog window.

**Disable**
Disable an element or part of a circuit. When the element or the circuit is disabled, it will be grayed out and will be treated as non-existent as far as the simulation is concerned. This function is useful if an element or circuit needs to be excluded but not deleted from the circuit.

**Enable**
Enable a previously disabled element or circuit.

**Rotate**
Rotate the selected element or a portion of the circuit by 90\(^\circ\) clockwise.

**Flip Left/Right**
Flip the selected element horizontally.
Flip Top/Bottom  Flip the selected element vertically.
Find  Find a particular element based on type and name.
Find Next  Repeat the previous Find operation.
Find in Files  Find a particular element in several files.
Edit Library  Edit image libraries. For more details, please refer to Section 2.13.
Image Editor  Launch the image editor.
Escape  Quit from any of the above editing modes by choosing Escape.

2.5 View Menu

The following functions are provided in the View menu for circuit editing:

- **Element List**  Display all the elements in a list.
- **Element Count**  Count the number of elements. Voltage/current probes and meters are not included in the element count.
- **Application Look**  Select the display style for the schematic windows.
- **Status Bar**  Show/hide the status bar.
- **Toolbar**  Show/hide the toolbar.
- **Element Toolbar**  Show/hide the element toolbar.
- **Library Browser**  Launch the Library Browser. The Library Browser is another way of accessing the Element library.
- **Project View**  Launch the Project View. The project view organizes and manages the related files. The projects organizing structure has been illustrated in Section 2.1
- **Simulation Message**  Launch the Simulation Message View to display messages.
- **Find Result View**  Launch the Find Result View.
- **Preview View**  Launch the Preview View.
- **Previous Page**  Display the previous page.
- **Next Page**  Display the next page.
- **Go to Page**  Go to the page of specific number.
- **Zoom In**  Zoom in the schematic.
- **Zoom Out**  Zoom out the schematic.
- **Fit to Page**  Adjust the zooming so that the entire schematic fits the screen.
- **Zoom In Selected**  Zoom in to the selected area.
- **Zoom Level**  Zoom the schematic to 10%, 20%, ..., 200%, and custom size.
- **Display Voltage/Current**  If the option *Save all voltages and currents* (under Options >> Settings >> General) is checked, after the simulation is complete, choose this function to display any node voltages or branch currents.
- **Display Differential Voltage**  With the option *Save all voltages and currents* checked, after the simulation is complete, choose this function to display any voltages between two nodes.
- **Refresh**  Refresh the screen display.

2.6 Subcircuit Menu

Functions provided in the Subcircuit menu are for subcircuit editing and manipulation.
### Chapter 2: Circuit Schematic Design

The following functions are to be performed in the parent circuit (outside the subcircuit):

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New Subcircuit</strong></td>
<td>Create a new subcircuit</td>
</tr>
<tr>
<td><strong>Load Subcircuit</strong></td>
<td>Load an existing subcircuit. The subcircuit will appear on the screen as a block.</td>
</tr>
<tr>
<td><strong>Edit Subcircuit</strong></td>
<td>Edit parameters the attributes dialog of the subcircuit.</td>
</tr>
<tr>
<td><strong>Open Subcircuit</strong></td>
<td>Open the selected subcircuit in a new window.</td>
</tr>
<tr>
<td><strong>Display Subcircuit Name</strong></td>
<td>Display the name of a selected subcircuit in the main circuit</td>
</tr>
<tr>
<td><strong>Show Subcircuit Ports</strong></td>
<td>Display the port names of the subcircuit in the main circuit</td>
</tr>
<tr>
<td><strong>Hide Subcircuit Ports</strong></td>
<td>Hide the port names of the subcircuit in the main circuit</td>
</tr>
</tbody>
</table>

The following functions are to be performed inside the subcircuit:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Place Bi-directional Port</strong></td>
<td>Place a bi-directional connection port in the subcircuit</td>
</tr>
<tr>
<td><strong>Place Input Signal Port</strong></td>
<td>Place an input signal connection port in the subcircuit.</td>
</tr>
<tr>
<td><strong>Place Output Signal Port</strong></td>
<td>Place an output signal connection port in the subcircuit.</td>
</tr>
<tr>
<td><strong>Display Port</strong></td>
<td>Display the connection port of the subcircuit</td>
</tr>
<tr>
<td><strong>Re-Order Port</strong></td>
<td>Arrange the sequence of ports in the subcircuit</td>
</tr>
<tr>
<td><strong>Edit Default Variable List</strong></td>
<td>Edit the default variable list of the subcircuit.</td>
</tr>
<tr>
<td><strong>Set Size</strong></td>
<td>Set the size of the subcircuit</td>
</tr>
<tr>
<td><strong>Edit Image</strong></td>
<td>Edit the subcircuit image</td>
</tr>
<tr>
<td><strong>One Page Up</strong></td>
<td>Go back to the main circuit. The subcircuit is automatically saved.</td>
</tr>
<tr>
<td><strong>Top Page</strong></td>
<td>Jump from a subcircuit to the top-level main circuit.</td>
</tr>
</tbody>
</table>

If the functions **Set Size**, **Display Port**, **Edit Default Variable List**, and **Edit Image** are performed in the main circuit, they will be applied to the main circuit instead.

There are three types of subcircuit ports for signal interface with the main circuit: Bi-directional port for power circuit and mechanical systems, and input signal and output signal ports for control circuit.

Even though bi-directional ports also work for control circuit, it is strongly recommended to use input or output signal ports for control circuit for better clarity. Furthermore, if a subcircuit is involved in code generation, only input or output signal ports can be used.

Either click the "Edit Subcircuit" menu or right click on top of a subcircuit block, and choose **Attributes** would open the subcircuit property dialog window. There are three tabs: **Change Subcircuit File**, **Subcircuit Variables**, **Formula**, and **Color**.

**Change Subcircuit File** Tab:

The name of the subcircuit can be edited in the **Name** box.

Click on the **Change Subcircuit File** button to change to a different subcircuit file. The selected subcircuit file will be loaded instead.

**Subcircuit Variables** Tab:

In this tab, variables used in the subcircuit can be edited. For example, a resistor in the circuit has the resistance defined as "Rparasitic", and for better clarity, this resistance is referred to as "Parasitic Resistance". Also, the resistance has a value of 1mOhm. This variable will be entered as:

- **Variable Description**: Parasitic Resistance
- **Variable Name**: Rparasitic
- **Variable Value**: 1m

When the checkbox for "Parasitic Resistance" is checked, in the main circuit, this variable will be displayed as:
Parasitic Resistance = 1m

Since subcircuit variable list can be edited, the current variable list may be different from the default variable list. One can click on the **Set as Default Variables** button to set the current variable list as the default list, or click on the **Reload Default Variables** button to reload the default list if the default list has been modified.

Two functions are provided at the bottom of the dialog for SimCoder for automatic code generation. Click on the **Generate Code** button to generate code for this subcircuit. If the checkbox **Replace subcircuit with generated code for simulation** is checked, the schematic inside the subcircuit will be replaced by the generated code for simulation.

**Formula Tab:**
In this tab, the condition for enable/disable the subcircuit can be set. The **Check Syntax** button will help user to check the syntax of the formula.

**Color Tab:**
In this tab, the subcircuit color can be changed.

**Example: Use of Subcircuit**
The circuit below illustrates the use of subcircuit. The circuit on the left is a buck converter, with the L-C filter inside a subcircuit. The content of the subcircuit is shown on the right.

In this example, there are two bi-directional ports ("in+" and "in-") on the left, and two bi-directional ports ("o+" and "o-") on the right.

---

2.6.1 **Creating Subcircuit - In the Main Circuit**

The following are the steps to create the subcircuit “sub.dsimsch” in the main circuit “main.dsimsch”.

- Open or create the main circuit “main.dsimsch”.
- If the file “sub.dsimsch” does not exist, go to the **Subcircuit** menu, and select **New Subcircuit**. If the file exists, select **Load Subcircuit** instead.
- A subcircuit block (rectangle) will appear on the screen. Place the subcircuit.

If the circuit that is to be converted into a subcircuit has already been created in the main circuit, a quick way of converting it into a subcircuit is to select the circuit, and then right click and choose **Create Subcircuit**. Specify the subcircuit file name as "sub.dsimsch", and the circuit will be converted into a subcircuit. Adjust the port location and wire connection if necessary.

2.6.2 **Creating Subcircuit - Inside the Subcircuit**

To enter the subcircuit, double click on the subcircuit block.

- Create/edit the content of the subcircuit circuit exactly the same way as in the main circuit.
- To specify the subcircuit size, select **Set Size** in the **Subcircuit** menu. In this example, the size is set to 5x6 (width of 5 divisions and height of 6 divisions). Note that the size of the subcircuit should be
chosen such that it gives the proper appearance and allows easy wire connection in the main circuit.

- Once the subcircuit is complete, define ports to connect the subcircuit nodes with the corresponding nodes in the main circuit. Choosing **Place Port** in the **Subcircuit** menu, and a port image will appear. After the port is placed in the circuit, a pop-up window (shown on the left below) will appear.

The diamonds on the four sides represent the connection nodes and the positions of the subcircuit. They correspond to the connection nodes of the subcircuit block on the right. There are no diamonds at the four corners since connections to the corners are not permitted.

When a diamond is selected, it is colored red. Click on the desired diamond to select and to specify the port name.

In this example, in the main circuit “main.dsimsch”, there are four linking nodes, two on the left side and two on the right side of the subcircuit block. The relative position of the nodes are that the upper two nodes are 1 division below the top and the lower two nodes are 1 division above the bottom.

To specify the upper left linking node, click on the top diamond of the left side, and type “in+”. The text “in+” will be within that diamond box and a port labelled with “in+” will appear on the screen. Connect the port to the upper left node. The same procedure is repeated for the linking nodes “in-”, “out+”, and “out-”.

- After the four nodes are placed, the node assignment and the subcircuit appear as shown below.

The creation of the subcircuit is now complete. Save the subcircuit, and go back to the main circuit.

### 2.6.3 Connecting Subcircuit - In the Main Circuit

Once the subcircuit is created and connection ports are defined, complete the connection to the subcircuit block in the main circuit.

- In the main circuit, the connection points on the borders of the subcircuit block appear as hollow circles.

- Select the subcircuit block, and select **Show Subcircuit Ports** in the Subcircuit menu to display the port names as defined inside the subcircuit.

- Connect the wires to the connection points accordingly.
2.6.4 Other Features of the Subcircuit

This section describes other features of the subcircuit through the example shown below.

2.6.4.1 Passing Variables from the Main Circuit to Subcircuit

In this example, the main circuit “main.dsimsch” uses a subcircuit “sub.dsimsch”. In the subcircuit, the inductance value is defined as “L” and the capacitance is defined as “C”. The default values of L and C can be set by selecting Subcircuit | Set Default Variable List. In this case, L is set to 5mH and C is set to 100uF.

When the subcircuit is loaded into the main circuit the first time, this default variable list will appear in the tab “Subcircuit Variables” in Subcircuit | Edit Subcircuit from the main circuit “main.dsimsch”. New variables can be added here and variable values can be changed. In this case, L is changed to 2mH, and C is kept the same as the default value.

Note that the variables and the values are saved to the netlist file and used in simulation. The default variable list inside the subcircuit is not saved to the netlist and is not used for simulation.

This feature allows the parameters of a subcircuit to be defined at the main circuit level. In the case where the same subcircuit is used several times in one main circuit, different parameters can be assigned to the same variable. For example, if the subcircuit “sub.dsimsch” is used two times in above example, in one subcircuit L can be defined as 3mH, and in another subcircuit L can be defined as 1mH.

Note that this example also illustrates the feature that parameters can be defined as a variable (for example “Vin” for the input dc voltage source) or a mathematical expression (for example “R1+R2” for the load resistance).
2.6.4.2 Customizing the Subcircuit Image

The following are the procedures to customize the subcircuit image of “sub.dsimsch”:

- In the subcircuit, select **Edit Image** in the **Subcircuit** menu. A window will pop-up, as shown below.

![Image Editor Window](image1)

In the window, the diamonds marked red are the connection nodes of the subcircuit block, in exactly the same positions as appearing in the main circuit.

- Use the drawing tool to create/edit the image for the subcircuit block. If the drawing tool is not already displayed, go to the **View** menu and check **Drawing Tools**. Click on **Zoom In** and **Zoom Out** icons on the toolbar to adjust the size of the image working area.

After the image is created, the pop-out window will appear as follows.

![Image Editor Window](image2)

- Go back to the subcircuit window (“sub.dsimsch” in this case), and save the subcircuit. The new subcircuit block image should appear in the main circuit.

2.7 Elements Menu

All the elements are stored under the **Elements** menu. They are stored in the following menus:

- **Power**: Power circuit elements, such as R, L, C, switching devices, transformers, motor drive modules, and etc.
- **Control**: Control circuit elements, such as computational, logic, digital control elements and etc.
- **Other**: Elements interconnecting power and control circuit, such as switch controllers, voltage/current sensors, probes, and etc.
- **Sources**: Various voltage and current sources
- **Symbols**: Symbols for drawing purpose, not for simulation usage
2.8 Simulate Menu

The following functions are provided in the Simulate menu:

- **Simulation Control**: Set the simulation parameters such as time step, total time, etc. When this is selected, the cursor will change to the image of a clock. Place this clock on the schematic, and double click to display the property window.
- **Run DSIM Simulation**: Run DSIM simulation
- **Cancel Simulation**: Cancel the simulation that is currently in progress
- **Pause Simulation**: Pause the simulation that is currently in progress
- **Restart Simulation**: Resume a paused simulation
- **Simulate Next Time Step**: Run the simulation to the next time step, and pause
- **Run SIMVIEW**: Launch the waveform display program SIMVIEW
- **Generate Netlist File**: Generate the netlist file
- **Generate Netlist File (xml)**: Generate the netlist file in xml format
- **View Netlist File**: View the generated netlist file
- **Show Warning**: Show the warning messages, if any, from the simulation.
- **Runtime Graphs**: Select waveforms to display in the middle of a simulation run.

The dialog window of the Runtime Graphs function has two tabs: Standard and Vector. The Standard tab lists the variables for time-domain waveform display. The Vector tab defines vectors for vector plot. The real and imaginary parts of a vector comes from the same variable list as in the Standard tab.

To view the simulation waveforms of output variables in the middle of simulation, one can either go to Simulate >> Runtime Graphs and select the variables, or right click on top of a voltage probe or current probe and select Runtime Graph Window from the menu.

A runtime graph display the waveform in its entirety, from the beginning to the final study time. Because of this, the runtime graphs are disabled in the free-run mode as the final study time is undetermined.

In the free-run mode, the majority of the element parameters can be changed during runtime in the middle of the simulation. This makes it possible to tune a circuit while inspecting key waveforms using voltage/current scopes, until desired performance is achieved.

2.9 Options Menu

The following functions are provided in the Options menu for various settings:

- **Settings...**: Launch the Settings dialog.
- **Languages**: Select different languages for the software.
- **Auto-run SIMVIEW**: Automatically run SIMVIEW after the simulation is complete.
- **Enter Password**: Enter the password to view a schematic file that is password protected.
- **Disable Password**: Disable the protection of a schematic file that is password protected.
- **Deactivate**: Deactivate the DSIM license. This is for softkey version only.
- **Check for Software Update**: Check if any newer software updates are available. This is for licenses that have the Annual Software Maintenance only.
2.9.1 Setting Option

The Settings dialog has three tabs: General, Advanced, Colors.

The General tab contains these sections: Editing, Text Font, Line thickness, and Simulation:

In the Editing section:

- **Display grid**
  - Check this option to display the grid in the schematic.

- **Zoom factor**
  - The zoom factor defined here is used when the schematic is zoomed in or out.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable rubber band</td>
<td>When checked, an element or a portion of a circuit remains connected with the rest of the circuit when moved.</td>
</tr>
<tr>
<td>Show print page border</td>
<td>When enabled, the border of the printout will be displayed.</td>
</tr>
<tr>
<td>Snap to grid draw objects</td>
<td>When enabled, the objects in the schematic will be snapped to grid.</td>
</tr>
<tr>
<td>In the Text Font section:</td>
<td></td>
</tr>
<tr>
<td>Default Text Font</td>
<td>Set the default font for the text placed in the schematic.</td>
</tr>
<tr>
<td>Justification</td>
<td>Define how the text will be aligned.</td>
</tr>
<tr>
<td>Runtime Graph Font</td>
<td>Set the text font for the runtime graphs.</td>
</tr>
<tr>
<td>In the Line thickness section:</td>
<td></td>
</tr>
<tr>
<td>Printing</td>
<td>Define the thickness of the line as it appears at the printout. It can be set from 1 (the thinnest) to 6 (the thickest).</td>
</tr>
<tr>
<td>Screen</td>
<td>Define the line thickness displayed on the screen. It can be set from 1 (the thinnest) to 6 (the thickest).</td>
</tr>
<tr>
<td>In the Simulation Section:</td>
<td></td>
</tr>
<tr>
<td>Simulation result format</td>
<td>Simulation results can be saved in either binary format (default) or text format. The binary format will result in a smaller result file, and will be faster to load.</td>
</tr>
<tr>
<td>Limit output buffer size</td>
<td>When checked, the simulation data will be written to the result file in segment. For example, if the buffer size is set to 50 MB, the simulation data will be first saved to the buffer, and when it reaches 50 MB, the whole 50-MB data will be written to the result file. Please note that the runtime graph only plots the data in the buffer. Therefore, when the old data are saved to the file and the new data fills in the buffer, the runtime graph will only show the waveform of the new data, and the old waveform will be lost. To retain all the waveforms in the runtime graph, one can either increase the buffer size, or un-check this option. When this option is un-checked, however, DSIM will allocate all the required memory for the buffer at the very beginning. If the simulation time step is small and the total time is long, and if there are many output curves, a very large memory may be required, which will take some time to allocate, and may even fail if the computer does not have sufficient amount of memory.</td>
</tr>
<tr>
<td>Disable simulation warning messages</td>
<td>When this option is checked, warning messages generated in the simulation are suppressed.</td>
</tr>
<tr>
<td>Save all voltages and current</td>
<td>When this option is checked, all the voltages and currents of the circuit will be saved for display. To display a voltage or current, after the simulation is complete and after results are loaded into SIMVIEW, choose View &gt;&gt; Display Voltage/Current (or click on the corresponding icon). When the cursor is on top of a node or a branch, it will change to the image of a voltage probe or current clamp probe. Left click the mouse, and the corresponding voltage or current will appear in SIMVIEW. To display a differential voltage, choose View &gt;&gt; Display Differential Voltage. Then click on the first node, and then the second node. The differential voltage waveform will appear in SIMVIEW.</td>
</tr>
<tr>
<td>Maximum number of points for oscilloscope</td>
<td>It defines the maximum number of points that an oscilloscope will plot. Increase this number to display waveforms for a longer time interval.</td>
</tr>
</tbody>
</table>
The Advanced tab contains these sections: Updates, Backup, Idle Time, Alternate Help File Path and Parameter File Variables.

In the Updates section:

Check for software updates
When this option is checked, if you have the valid software annual maintenance, DSIM will automatically check for new updates on the DSIM server. If a new update is available, you will be prompted to install the update.

In the Backup section:

Create backup files
When this option is checked, DSIM will create a backup of the file currently being edited in the time interval specified. In case of a program crash, the backup file will preserve the previous work. The backup file is deleted automatically when the file is closed normally from the DSIM environment.

In the Idle Time (for network version) section:

Idle time
This setting applies to the network version only. When this option is checked, DSIM will be timed out, after the program is idle for the specified amount of time.

When DSIM is timed out, the license will be released and other users will be able to check it out. When DSIM is back from the idle state, it will try to log back in the License Manager if a license is still available. If there is no license available, an error message will be posted.

This feature is to prevent users from holding up licenses unintentionally.

In the Parameter File Variables section:

Significant digits
It defines the number of significant digits for variables defined in a parameter file and used in a C block. For example, if k1 is defined as "k1 = 10/3" and the number of significant digits is defined as 8, a value of k1=3.3333333 will be used.

Delete SIMVIEW files on exit
If this option is checked, DSIM will delete simulation output files of the current session on exit.

The Colors tab defines the colors for grids, elements, subcircuits, ports, wire, text, nodes, and labels.

2.10 Utilities Menu

Several utility programs are provided under the Utilities menu.

Parameter Tool
It launches a parameter file window. One can load an existing parameter file, or enter expressions for computation purposes.

Script Tool
The script tool allows one to run a script.

Curve Capture Tool
Tool to capture curves from manufacturer datasheet. The captured data can be plotted using SIMVIEW, or used in lookup tables. This tool can also be used to read the x/y values from a curve.

To start the capture process, click on the right arrow at the upper left corner of the dialog window.

Unit Converter
This program performs unit conversion in length, area, weight, and temperature.

Calculator
This will launch the Windows’ calculator.

2.11 Window Menu

This menu contains the commonly used window managing functions:
2.12 Help Menu

This menu contains the material collection to guide and assist users utilizing DSIM’s features and functions. It has the following functions:

- Search Help: Search information with keywords
- Documents: User manuals
- Tutorials: Tutorials
- Video Tutorials: Video tutorial links
- Online Support: Online support links
- Official User Forum: Online user forum
- Live Webinar Sign Up and Archive: Online webinar links
- Tip of the Day: Tips
- About: DSIM’s version, license and active module information

2.13 Managing the Element Library

A library element consists of two parts: the netlist part and the image part. The netlist part comes from the netlist library, and there is only one netlist library, dsim.lib. The netlist library cannot be edited.

The image part comes from an image library. There can be multiple image libraries, and all the image libraries in the DSIM directory will be automatically loaded into DSIM. The standard image library provided by DSIM is dsimimage.lib. This file also cannot be edited. However, in order to facilitate users to copy images from the standard image library, the standard image library can be viewed by going to Edit >> Edit Library >> Edit library files, and choosing dsimimage.lib.

Users can create their own custom image libraries. To create a new custom image library, go to Edit >> Edit Library >> Edit library files, and click on New library. Then define the library name as it appears in the Elements menu, and the library file name. This library file will be created and placed in the DSIM directory.

2.13.1 Creating a Secondary Image

It is possible that some users may find certain element images in the standard image library dsimimage.lib different from what they are used to use. In this case, users can create their own secondary images.

A secondary image can be created for an element in either standard image library dsimimage.lib or users’ own custom image libraries. Secondary images are saved in a secondary image library with the .lib2 extension.

To illustrate the process, a secondary image will be created in the library "mylib.lib2" for the "Resistor" element in the standard image library.

- Go to Edit >> Edit Library >> Edit secondary image library files, and click on New library. In the dialog, define the secondary image library name as "mylib.lib2".
- Then select "mylib.lib2" and click on Edit selected library. The dialog window for editing secondary image library will appear.
- Click on the Add button. From the library tree, navigate to Power >> RLC branches, and select "Resistor". The element "Resistor" will appear in the list of the secondary images. The text "DSIMIMAGE" in front of the "Resistor" text shows that this is for the diode element in the standard image library dsimimage.lib.
• Highlight "Resistor", and click on the **Edit** button to create the image.
• If this image is to be used as the default image for this element, click on the "**Set as Default Image**".

After the secondary image is created, this image will be available for selection in the schematic. For example, if a resistor is placed on the schematic, double click to display the property dialog of the diode, then click on the **Color** tab. Click on the pull-down arrow, and two images will be displayed. One from the standard image library, and the other from the custom image library mylib.lib2.

If the secondary image is selected, all the images of the same element will be automatically changed to the secondary image. The selected image will also be set as the default image when a schematic is created or loaded the next time.

To share the secondary images that one creates with other people, one just has to send to them the secondary image library file (with the .lib2 extension).

### 2.13.2 Adding a New Subcircuit Element into the Library

Users can add the custom model directly to an image library. The advantage of this approach is that the custom element will have the same look-and-feel as the standard library elements, giving it a better interface. It is also possible to associate a help file to the custom model.

There are three main steps to add a new element, modeled in a subcircuit, into the library:
- Create the subcircuit model of the new element.
- Add this element to the DSIM library.
- Create an on-line help file for this new element.

To illustrate this process, a LC-filter element is used as an example.

**Step 1: Create Subcircuit**

The first step is to create the subcircuit of the new element in the same way as if the subcircuit is to be called by another circuit. For example, the subcircuit of the 2nd-order LC filter, called "LC_filter.dsimsch", and its image are shown below:

![LC Filter Subcircuit](image)

In this case, the inductance and capacitance values will be defined through the interface, and need to appear in the property window of the new LC filter element. Therefore, the parameter value for the inductance needs to be defined as a variable, in this case, \( L \), and the value for the capacitance as \( C \).
Then from **Subcircuit >> Edit Default Variable List**, add the variables $L$ and $C$ as the default variables. This step is necessary as the new element obtains the parameter information from the default variable list. The default variable list window should appear as follows.

Here **Variable Label** is the text that describes the parameter, **Variable Name** is the variable that is used as the parameter value in the subcircuit, and **Variable Value** is the default value of the parameter. In the example, for the inductor $L$, the **Variable Label** is *Inductance*, the **Variable Name** is $L$, and the **Variable Value** is 1m. For the capacitor $C$, the **Variable Label** is *Capacitance*, the **Variable Name** is $C$, and the **Variable Value** is 100u.

After the file is created, place it in the "lib" sub-folder in the DSIM directory.

**Step 2: Add the New Element to the Library:**

To add the subcircuit element into the library, follow these steps:

- Go to **Edit >> Edit Library >> Edit Library Files**, and choose the custom image library for the new element. Click on **New Library** to create a new image library, or select an existing library and click on **Edit Selected Library**.
- In the Library Editor, click on the button **New Element (Subcircuit)**. Enter the information to the dialog window as shown below:

  - **Name:** Name of the new element as it appears in the library
  - **Description:** Description of the new element
  - **File Path:** The location of the subcircuit schematic file "LC_filter.dsimsch". The schematic file of the subcircuit must be placed in the "lib" sub-folder in the DSIM directory.
  - **Input nodes:** Number of input nodes.
  - **Output nodes:** Number of output nodes.
  - **Hide (menu):** Leave this box unchecked. If this box is checked, this element will not appear in the library.
  - **Help File:** On-line help file associated with this element. This file must be placed in the "help" sub-folder in the DSIM directory. When the **Help** button is clicked in the property dialog window, this file will be displayed. This file can be a text file (which can be opened by a text editor such as NotePad) or a HTML file.

  - Click on the buttons **Save Image Library** and **Update Menu**. The new element will appear in the library and will be ready to use.
SIMVIEW reads data either in ASCII text format or in SIMVIEW binary format. The following shows a sample text data file:

<table>
<thead>
<tr>
<th>Time</th>
<th>Isa</th>
<th>Isc</th>
<th>Isb</th>
<th>Tem_IM</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.000000000E-006</td>
<td>0.000000000E+000</td>
<td>0.000000000E+000</td>
<td>0.000000000E+000</td>
<td>7.14588260E-048</td>
</tr>
<tr>
<td>1.000000000E-005</td>
<td>0.000000000E+000</td>
<td>0.000000000E+000</td>
<td>0.000000000E+000</td>
<td>1.082981714E-046</td>
</tr>
<tr>
<td>1.500000000E-005</td>
<td>0.000000000E+000</td>
<td>0.000000000E+000</td>
<td>0.000000000E+000</td>
<td>3.598226665E-015</td>
</tr>
<tr>
<td>2.000000000E-005</td>
<td>1.139566166E-001</td>
<td>-2.279132474E+000</td>
<td>1.139566166E-001</td>
<td>1.613605209E-017</td>
</tr>
<tr>
<td>2.500000000E-005</td>
<td>5.072914178E-001</td>
<td>-1.014582858E+000</td>
<td>5.072914178E-001</td>
<td>3.598226665E-015</td>
</tr>
</tbody>
</table>

Functions in each menu are explained in the following sections.
3.1 File Menu

The File Menu has the following functions:

- **Open**: Load a data file in ASCII text format (with .txt extension) or SIMVIEW binary format (with .smv extension).
- **Merge**: Merge another data file with the existing data file for display.
- **Re-Load Data**: Re-load data from the same text file.
- **Save As**: Save the waveforms to either binary data format or text format. When saving to the binary format, the current settings are also saved. To export data from the display for other purpose, select text format from the "Save as type" pull-down list. In the FFT display, this will save the FFT results to a text file specified by the user.
- **Save Display As**: Save the displayed waveforms to text format.
- **Print**: Print the waveforms.
- **Print Setup**: Set up the printer.
- **Print Page Setup**: Set up the hardcopy printout size.
- **Print Preview**: Preview the printout.
- **Exit**: Quit SIMVIEW.

When the data of a file are currently being displayed, if new data is available, by selecting **Re-Load Data**, new data will be loaded and waveforms will be re-drawn.

With the **Merge** function, data from multiple files can be merged together for display. For example, if one file contains the curves “I1” and “I2”, and another file contains the curves “V1” and “V2”, all four curves can be merged and displayed on one screen. If the second file also contains a curve with the same name “I1”, it will be modified to “I1_{second_file_name}” automatically where **second_file_name** is the name of the second file.

3.2 Edit Menu

The Edit Menu has the following functions:

- **Undo**: Go back to the previous X and Y axis settings.
- **Copy to Clipboard**: Copy the waveforms to the clipboard either in metafile format or bitmap format.
- **View Data Points**: View the data points of the waveforms within the displayed range in a separate window. In this window, one can use the left mouse to highlight data points in rows or columns, then right mouse click and choose **Copy Selected** to copy the data to the clipboard. One could also just copy the row that the cursor is on by selecting **Copy Row**, or copy the entire data by selecting **Copy All**. One can then paste the copied data back in another program.

Note that the **Copy to Clipboard** function will copy the displayed waveforms on the screen to the clipboard. To save the memory and have the waveform image in black & white, first go to **Option** and de-select **Color** to have a black & white display, then copy the waveform to the clipboard.

3.3 View Menu

The View menu has the following functions:

- **Application Look**: Select the display style for the schematic windows.
- **Zoom**: Zoom in to selected area.
- **Redraw**: Redraw the display.
One key feature of the calculator is that it provides 9 memory spaces. By double clicking on a number in the Measure dialog window in Simview, the value will be automatically transferred to the calculator and stored in one of the memory spaces, starting from the top. In this way, data can be directly transferred to this calculator for calculation without the need to record them on a piece of paper.

3.4 Axis Menu

The Axis Menu has the following functions:

- **X Axis** Change the settings of the X axis
- **Y Axis** Change the settings of the Y axis
- **Choose X-Axis** By default, the first column of the data is selected as the X axis. However, other columns can also be selected as the X axis through this function.

When any of the settings are modified from the default values, user must use "Settings >> Save Settings" to keep the modification so that, when next time the same schematic simulation is run, the same settings will be displayed in SimView for the result.
Chapter 3: Waveform Display in SIMVIEW

3.4.1 X-Axis Settings

There are three sections for X-Axis settings:

- **Scale**: The display of X-axis can be set either as Linear or Log.
- **Range**: The range, the scale text color and font, as well as text’s tilting angle can be set.
- **Grid Division**: The grid’s style and color can be set. If the Auto-Grid box is checked, the number of axis divisions will be automatically determined.

3.4.2 Y-Axis Settings

In addition to the three sections same as in X-axis setting:

- **Display Style**: Normal: Default waveform display. Timing Display: Display timing relations between the variables in the same screen.
- **New Y Axis**: Add additional Y-axis in the same screen for different variables.
- **Delete Y Axis**: Delete unwanted Y-axis in the screen.

3.4.3 Choose X-Axis Variable

By default, the first column of the data file is set as the X-axis. In most off the simulation result, it would be the time. In AC sweep simulation result, it would be the frequency.

This option allows user to select other columns from the pull-down list as the X-axis variable.
The following figure shows a sine waveform is chosen as the X-axis versus a cosine waveform in the Y axis.
3.5 Screen Menu

The Screen Menu has the following functions:

- **New Window** Create a new window for the active simulation result data file. This function is useful for viewing additional curves in a new window.
- **Add/Delete Curves** Add or delete curves in the selected screen
- **Add Screen** Add a new screen to currently opened window
- **Delete Screen** Delete the selected screen
- **Plot Vector Diagram** Plot the vector diagram. A vector is defined by its real and imaginary parts. This option will open the dialog for user to select the variables to be the "Real" and "Imaginary" parts of vector variables. The variables come from the same variable list as in the time-domain plot.
- **Display in Full Screen** Expand the SIMVIEW window to full screen
- **Move Up** Move the selected screen up
- **Move Down** Move the selected screen down

A screen is selected by clicking the left mouse on top of the screen.

3.5.1 Screen Properties Dialog

When a new screen is added or Add/Delete Curves function is selected, the dialog for screen properties would open, It contains three tabs:

- **Select Curves** Select the curves to be displayed
- **Curves** Set the color, thickness, and marker for curves
- **Screen** Set the color and font for the screen.

Any settings in this section, if modified from the default, must be saved using "Settings >> Save Settings" in order to be effected for the next time when the same smv file is launched.

To keep the modifications permanent as the default for all new smv files, please go to the section for Options.

The Select Curves tab of the properties dialog of a screen is shown below:

![Properties Dialog](image)

All the variables available for display are in the Variables Available box, and the variables currently being displayed are in the Variables for Display box. After a variable is highlighted in the Variables Available box, it
can be added to the Variables for Display box by clicking on “Add ->”. Similarly, a variable can be removed from display by highlighting the variable and clicking on “<- Remove”.

In the Edit Box, mathematical expressions can be specified. A mathematical expression can contain brackets and is not case sensitive. The following math functions are allowed:

+ addition
- subtraction
* multiplication
/ division
^ to the power of [Example: 2^3 = 2*2*2]
SQRT square-root function
SIN sine function
COS cosine function
TAN tangent function
ATAN inverse tangent function
EXP exponential (base e) [Example: EXP(x) = e^x]
LOG logarithmic function (base e) [Example: LOG(x) = ln (x)]
LOG10 logarithmic function (base 10)
ABS absolute function
SIGN sign function [Example: SIGN(1.2) = 1; SIGN(-1.2) = -1]
AVG moving average function that calculates the average of the curve up to the measured point.
AVGX periodic average function AVGX(y, Tp) where y is the curve name and Tp is the time interval where the average is calculated. Calculates the average of the curve y in each time segment with interval of the time segment as Tp. For example, AVGX(V1, 0.016667) will calculate the average of the curve V1 at the 60-Hz interval.
INT integration function

Type an expression in the Edit Box and click the "Add ->" button to add the calculated curve to the screen. Highlight the expression on the right and click the "<- Remove" button, the expression will be moved into the Edit Box for further editing.

The Curves and the Screen tabs of the properties dialog are shown below.

In the Curves tab, the curve properties, such as color, line thickness, marker symbol, and label, can be defined. In the Screen tab, the screen properties, such as foreground/background colors, grid color, and font size/type, can be defined. A dialog window is shown below.
3.5.2 Plot Vector Diagram

To plot a vector diagram, first perform the simulation. Then select Plot Vector Diagram and define the vectors. An example is used to illustrate this, as shown below.

In this circuit, the real and imaginary parts of two vectors V1 and V2 are created. The amplitude of V1 is 1 and the amplitude of V2 is 0.8. Vector V2 is leading V1 by 30 deg.

After simulation is completed, select Screen >> Plot Vector Diagram. In the dialog window, define the real and imaginary parts for vectors V1 and V2. The dialog window will appear as follows:
Click on OK, and the vector plot will show as below on the right. The time-domain waveforms of the real and imaginary parts of V1 and V2 are shown below on the left.

There is a sliding bar at the bottom of the vector plot. By sliding it with the left mouse, one can replay the drawing of the vector plot. The percentage shows the vector positions with respect to the final position of the drawing. For example, in this case, the time is from 0 to 0.0167 sec. A sliding bar of 0% corresponds to the moment at 0 sec., and 100% corresponds to the moment at 0.0167 sec.

### 3.5.3 In-Screen Operations

Inside each waveform display screen, right-clicking the mouse, the following operations can be performed:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Undo</strong></td>
<td>Undo the last change made to the screen.</td>
</tr>
<tr>
<td><strong>Copy to Clipboard</strong></td>
<td>Copy the waveforms to the clipboard in either bitmap or metafile format.</td>
</tr>
</tbody>
</table>
| **View Data Points**    | View the data points of the waveforms within the displayed range in a separate window. In this window, one can use the left mouse to highlight data points in rows or columns, then right mouse click and choose the following operations:  
  - Send to Calculator  
  - Copy Cell  
  - Copy Row  
  - Copy Selected  
  - Copy all  
  - Select All  
  - Save As  
  One can then paste the copied data back in another program. |
| **Add/Delete Curves**  | Opens the graph’s property window, as explained above.       |
| **X-Axis**             | Change the settings of the X axis.                           |
| **Y-Axis**             | Change the settings of the Y axis.                           |
| **OverView Box**       | Open an overview box for the selected screen.                |
| **Split View**         | Split the SimView Window into multiple view frames. The view frame option is defined as n*m, where n is the number of views tiled vertically, and m is the number of views tiled horizontally. |
### 3.6 Measure Menu

The **Measure Menu** has the following functions:

- **Measure**: Enter the measure mode.
- **Mark Data Point**: Mark the x and y coordinate values of the data point on a selected curve.
- **Max**: Find the global maximum of a selected curve.
- **Min**: Find the global minimum of a selected curve.
- **Next Max**: Find the next local maximum of a selected curve.
- **Next Min**: Find the next local minimum of a selected curve.

The Measure function allows the measurement of waveforms.

In Measure mode, by clicking the cursors and dragging the mouse, the values of the waveforms will be displayed. The difference between the two positions will be measured.

A SIMVIEW window with the measure dialog window is shown below.


### 3.7 Analysis Menu

The **Analysis Menu** has the following functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perform FFT</td>
<td>Perform the FFT (Fast Fourier Transform) analysis of time-domain waveforms</td>
</tr>
<tr>
<td>Display in Time</td>
<td>Show the corresponding time-domain waveforms of FFT results</td>
</tr>
<tr>
<td>Avg</td>
<td>Calculate the average value</td>
</tr>
<tr>
<td>Avg(</td>
<td>x</td>
</tr>
<tr>
<td>RMS</td>
<td>Calculate the rms value</td>
</tr>
<tr>
<td>PF (power factor)</td>
<td>Calculate the power factor of two waveforms on the screen. The screen must display two curves only.</td>
</tr>
<tr>
<td>P (real power)</td>
<td>Calculate the real power of two waveforms on the screen. The screen must display two curves only.</td>
</tr>
<tr>
<td>S (apparent power)</td>
<td>Calculate the apparent power of two waveforms on the screen. The screen must display two curves only.</td>
</tr>
<tr>
<td>THD</td>
<td>Calculate the THD (total harmonic distortion)</td>
</tr>
</tbody>
</table>

All these functions apply to the time interval (X-axis range) currently being displayed on the screen.

By selecting **Perform FFT**, the harmonic spectrum (both the amplitudes and angle) of the time-domain waveforms can be calculated and displayed. To display the angles of the FFT results, double click on top of the screen (or click on the **Add/Delete Curves** icon). In the **Select Curves** tab, click on the **Angle** tab, and select the angles. The name convention of angles is `Angle(D)_{name}` for the angle in deg., and `Angle(R)_{name}` for the angle in rad., and `name` is the curve name in the time domain.

**Note:** that, in order to obtain correct FFT results, the simulation must reach the steady state, and the data range must be restricted (using the manual range setting in the **X Axis** function) to have the integer number of the fundamental period. For example, for a 60-Hz fundamental frequency, the data length in display must be integer multiples of 1/60 sec.

### 3.8 Label Menu

The **Label Menu** has the following functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Place text on the screen</td>
</tr>
<tr>
<td>Line</td>
<td>Draw a line</td>
</tr>
<tr>
<td>Dotted Line</td>
<td>Draw a dotted line</td>
</tr>
<tr>
<td>Arrow</td>
<td>Draw a line with arrow</td>
</tr>
</tbody>
</table>

To draw a line, first select **Line** from the Label menu. Then click the left mouse at the position where the line begins, and drag the mouse while keeping the left button pressed. Dotted lines and lines with arrows are drawn in the same way.
If one is in the Zoom or Measure mode, and wishes to edit a text or a label, one should first escape from the Zoom/Measure mode by selecting “Escape” in the “View” menu.

3.9 Option Menu

The Option Menu defines the default settings for SimView window displays. It has the following functions:

- **Default Display Settings**: Launch the "Options" dialog for default settings for SimView displays.
- **Grid**: Enable or disable the grid display
- **Color**: Set the curves to be either Color (default) or Black and White
- **Re-Load Settings**: Re-load the settings from the .ini file and apply to the current display
- **Save Settings**: Save the current settings to a file with the same file name but with the .ini extension
- **Save Temporary Settings**: Save the current settings temporarily. The temporary settings are not saved to any files, and are discarded when the document is closed.
- **Load Temporary Settings**: Load the temporary settings and apply to the current display
- **Add to Favorites**: Save the current settings as a favorite. When saving a favorite, one can choose to save the following settings: line color and thickness, text font, Log/dB/FFT display settings, and x and y axis ranges.
- **Manage Favorites**: Manage the favorites

The default settings in the Options dialog are the permanent settings each time a new SimView file is opened. Any modification in this dialog will not be in effect immediately to the screen display in the already opened SimView windows. They will start to be in effect when the SimView window is opened next time.

The settings in the Screen Properties dialog are in effect for SimView display immediately. However, those settings will not be kept once the SimView is closed. To save those settings, user can use "Settings >> Save Settings" to keep those display for the same SimView data file. But those display won’t be applied to other SimView data files.

The Options dialog window is shown below.

If the option **Redraw x-axis when loading new data** is checked, the waveform will be redrawn with the new x-axis range when new data is loaded. If this option is not checked, the x-axis range will be unchanged.
If the option **Engineering Unit** is checked, in the Measure dialog window, curve values will be displayed in engineering unit with suffix such as u, m, k, M (for example, 12.3456u). If this option is not checked, the values will be displayed in scientific unit (for example, 1.23456e-5). The value of **Significant Digits** defines the number of digits after the decimal points.

Also, the **Right mouse action** can be set to either *Show menu, Pan, or Zoom*.

**Default curve settings** specifies colors, line thickness, and mark symbols for curves.

**Default Screen settings** specifies colors, font style and size for screens.

**Default text item settings** specifies colors, font style and size for text items.

When Simview loads a data file (.txt or .smv file), if the corresponding .ini file exists, it will load the settings in the .ini file.

The functions **Load Temporary Settings** and **Save Temporary Settings** are used in situations where one wants to save the settings temporarily and uses it shortly after. For example, when comparing one waveform with another, one can first save the temporary settings when displaying the first waveform. Then display the second waveform and load the temporary settings.

Favorites are a convenient way of storing particular graph settings to be used later. For example, assume that Simview shows two screens, with the top screen displaying V1 in the red color and with certain x-axis and y-axis ranges, and the bottom screen displaying V2 in the blue color with its own y-axis range. If this settings is likely to be used again in the future, the settings can be saved as a favorite and used later.

To apply a favorite to the current display, go to the Settings menu and choose the favorite from the list. Note that when applying the favorite, the number of screens currently on display must be the same as the number of screen in the favorite.

### 3.10 Exporting Data

FFT results can be saved to a text file. Both simulation results (*.txt) and FFT results (*.fft) are in text format and can be edited using a text editor (such as Microsoft Notepad), or exported to other software (such as Microsoft Excel).

For example, to load a simulate result file “chop-1q.txt” in Microsoft Excel, follow these steps:

- In Microsoft Excel, select **Open** from the File menu. Open the file “chop-1q.txt”.
- In the dialog window **“Text Import Wizard - Step 1 of 3”**, under **Original data type**, choose **Delimited**. Click on **Next**.
- In the dialog window **“Text Import Wizard - Step 2 of 3”**, under **Delimiter**, choose **Space**. Click on **Next**.
- In the dialog window **“Text Import Wizard - Step 3 of 3”**, under **Column data format**, choose **General**. Click on **Finish**.
The high performance of DSIM and its ability to simulate switching transients makes it an ideal solution for large scale power converter systems, high power converter systems, microgrid, and any systems that are computation intensive. In this chapter, some examples are described to show how DSIM empowers the design and research of relatively complicated systems.

4.1 Example 1: 200kHz LLC Circuit

LLC circuit usually operates in a high-frequency range. With conventional simulation approach, very small simulation time step is needed to get correct results, making the whole simulation time consuming. DSIM offers an event-driven mechanism which greatly shortens the simulation time. This LLC circuit can be found under examples >> DSIM >> LLC converter (200kHz).

The following figure shows the circuit structure. The studied case is a LLC isolated bidirectional DC-DC converter, with a variable-frequency control around 200kHz. A variable-frequency square wave controller is used to generate the switching signals. Note that for simplicity, the same switching signals are used for both primary and secondary side bridges. This is not the case in practice, but just an approximation to show the performance of DSIM in similar cases.

To use an existing simulation tool with fixed step-size, a very small time step must be selected. A test result is shown in the following figure, where the simulated waveforms of the output DC voltage $V_o$ under different time steps are shown. It can be observed that any time step larger than $1e-9s$ is not enough to get correct waveforms.
With 1e-9s time step, existing tool takes more than 20 minutes for 0.1 second simulation. However, with the Discrete State Event-Driven algorithm, DSIM takes less than 1 second to get the same results, which is more than 1300 times faster. The following figure shows the comparisons of the simulated results, where Vo is the output DC voltage, and Vcr is the resonant capacitor voltage. The tests are conducted with an Intel Core i7-6600U CPU.

4.2 Example 2: 50kVA Solid-State Transformer

This example shows a 50kVA solid-state transformer (SST). The system consists of three stages, as shown in the following figure. It is tested under a 5-second grid-side low-voltage ride-through dynamic, where the waveform of the grid-side voltage is also shown below.
The DSIM circuit of this example is shown below.

50kVA Solid-State Transformer

For the 5-second dynamic, if ideal switch model is used, DSIM takes less than 5 second to finish the simulation, which is about 50 times faster than current software; if transient switch model is used, DSIM takes about 50 seconds, which is 700 times faster than another commercial software. The comparisons are shown as below. The tests are conducted with an Intel Core i7-7700K CPU.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Device Model</th>
<th>Solver</th>
<th>CPU Time (s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software A</td>
<td>IGBT/PIN diode: (\text{igbt_b}) and (\text{dp1})</td>
<td>Trapezoidal method and Newton-Raphson iteration</td>
<td>33712.0 (9h 21min 52s)</td>
</tr>
<tr>
<td>Software A</td>
<td>SiC MOSFET/SiC SBD: (\text{mp1}) and (\text{dp1})</td>
<td>Ode23tb (Rapid mode)</td>
<td>250.9</td>
</tr>
<tr>
<td>DSIM</td>
<td>Ideal switch model</td>
<td></td>
<td>51.8</td>
</tr>
<tr>
<td>DSIM</td>
<td>Transient model (PAT)</td>
<td>DSED</td>
<td>47.0</td>
</tr>
<tr>
<td>DSIM</td>
<td>Ideal model</td>
<td>DSED</td>
<td>4.82</td>
</tr>
</tbody>
</table>

The simulated results are in good agreements with experimental results. Some comparisons of the grid-side waveforms and the DC-link voltage are shown below.
The PAT model in DSIM also gives good results compared with measured ones, as shown below.

4.3 Example 3: 10kV four-port Solid-State Transformer

This example shows how DSIM helps to simulate a very large system: a four-port solid-state transformer (SST), also known as electric energy router (EER). It consists of 576 switches in total and the rated power for each port is 1MW. The system diagram and the circuit built in DSIM is shown below.
To simulate a 0.2s dynamic, DSIM takes only 17 seconds, which is more than 1000 times faster than a commercial software specialized in power electronics, while the simulated results are very close, with less than 0.01% relative error, as shown below. DSED represents the DSIM algorithm.

### 4.4 Example 4: Experimental Verifications of the Transient Model

This example shows the experimental verifications of the PAT model in DSIM. Double pulse tests are conducted on Infineon IGBT FZ600R65KF1 (6500V, 600A). Some experimental results are shown as below.
Generally PAT model gives good results compared with experimental waveforms, if the input parameters are accurate enough. Under some small-current conditions, the model error can be larger.